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SymbolLogic 
ECAV 4.0 Quick Reference Guide 

 
Introduction 

 
Stop! Don’t jump into a new project just yet. Read through this quick reference guide at least once. 

Even if you’re a seasoned Visio user, clear your mind, because this is not just Visio anymore, it’s 

Engineering Complete AV (ECAV), the future of AV technology documentation. 

  

ECAV is a Visio template application suite developed and refined over 25 years for the purpose of 

providing uncompromised but quickly produced system design and engineering documentation. It uses 

a practical and proven process for providing all documentation needed to get your installations 

finished efficiently and accurately.   

  

ECAV is not a starter app or wizard, but a tool designed to assist already skilled professionals, with an 

awareness of industry methods and requirements, to rapidly deliver concise documents for their 

organizations. Like the skill set required with other professional architectural and design applications, 

ECAV expects users to know their way around the Visio environment. And with Symbol Logic training 

videos, even a novice engineer with system installation experience can get swiftly up to speed.  

  

Unlike other template apps, ECAV doesn’t try to be all things to all people. It takes a very specific 

approach to engineering documentation based on decades of review, experience and refinement. One 

example is ECAV’s unique block diagram which provides a host of integrated features and the ability to 

quickly visualize a project’s size and scope before choosing products. If you observe an approach that 

seems inconsistent from your experience, dig deeper into ECAV’s methods – We believe you’ll find 

unexpected merit. 

  

Experiment with the example drawing while reading through the five Quick Reference sections to get a 

hands-on feel for the ECAV process: Setup, AV Floor Plan, Block Diagram, Rack and Room Schematics, 

and Equipment Rack Elevations. 

 

After just a little time we know you’ll agree ECAV is the future of AV technology documentation. 
 



Page 2 of 25 
 

Symbol Logic Copyright © 2021  ECAV-Quick Reference Guide  

 
Table of Contents 

 

1. ECAV Setup …………………………………………………………………………………………………………………………. Page 4 
1.1. Create your Company Template  

1.1.1.  Title Page, Company, Regional and Template Settings 
1.1.2.  Import the ECAV Stencils 
1.1.3.  Stencil File Locations  
1.1.4.  Saving Custom Symbols to the Stencils 
1.1.5.  Quick Access Toolbar 
1.1.6.  Company Logo, Title, Background and Foreground Pages 
1.1.7.  Save your New Company Template 

1.2. Create your Engineering Database ………………………………………………............……………………. Page 7 
1.3. Link your Database to your Drawings……………………………………………………......................... Page 7 
1.4. Important Drawing Notes……………………………………………………………………………………………… Page 7 

1.4.1.  The Drawing Process 
1.4.2.  Example Drawings and ECAV Help 
1.4.3.  Gridlines and Guides 
1.4.4.  Snap and Glue 
1.4.5.  Wire Labeling 
1.4.6.  Symbol Features and Display Options 

2. ECAV AV Floor Plan…………………………………………………………………………………………………………. Page 9 
2.1. Purpose  
2.2. Procedure 

2.2.1.  Insert an Architectural Floor Plan Image 
2.2.2.  Drop Floor Plan Device Legend Symbol 
2.2.3. Drop North Symbol 
2.2.4. Drop AV Floor Plan Device Symbols  
2.2.5. Resize Device Symbols 
2.2.6. Configure Device Symbols 
2.2.7. Drop AV Floor Plan Wire Symbols 
2.2.8. Configure Wire Symbols 
2.2.9. Reposition Wire Handles 
2.2.10. Set Display Options for Device and Wire Symbols 
2.2.11. Labeling Floor Plan Wires 
2.2.12. Customize AV Floor Plan Symbol Icons 
2.2.13. AV Floor Plan Symbol Features and Display Options (Figures 12 and 13) 

3. ECAV Block Diagram……………………………………………………………………………………………………     Page 13  
3.1. Purpose 
3.2. Procedure 

3.2.1.  Drop Room Symbols 
3.2.2.  Floor-Bar Symbols 
3.2.3.  Drop Room Area Symbols 
3.2.4.  Drop Headend Area Symbols 
3.2.5.  Drop Device Symbols 



Page 3 of 25 
 

Symbol Logic Copyright © 2021  ECAV-Quick Reference Guide  

 
 

3.2.6.  Type-in Device Names 
3.2.7.  Drop Room Wire Symbols 
3.2.8.  Check Room Designs and Symbol Positions 
3.2.9.  Assign Groups to Room Wires 
3.2.10. Assign Average Project Wire Length 
3.2.11. Drop and Configure Headend Wire Groups 
3.2.12. Assign Room Wire IDs 
3.2.13. Drop Prewire Schedules 
3.2.14. Interconnect Block Devices 
3.2.15. Check Headend Designs and Symbol Positions 
3.2.16. Link your Company Data to Device Symbols 
3.2.17. Drop Block Diagram Device Legend and BoM Report Symbols 
3.2.18. Block Diagram Symbol Features and Display Options (Figures 14-17) 

4. ECAV Schematics…………………………………………………………………………………………………………………Page 18 
4.1. Purpose 
4.2. Procedure 

4.2.1.  Name the Rack and Room Outline Symbols 
4.2.2.  Transform Headend Block Devices into Schematic Devices 
4.2.3.  Reposition Schematic Device Symbols 
4.2.4.  Create Schematic Device I/Os 
4.2.5.  Reposition Completed Schematic Symbols 
4.2.6.  Transform Block Diagram Room Wires into Schematic Wires 
4.2.7.  Drop and Connect Interconnect and Reference Wire Symbols 
4.2.8.  Label Interconnect Wire Symbols 
4.2.9.  Check All Rack Connections and Headend Design 
4.2.10. Show Tech-Installed Wires 
4.2.11. Repeat Procedure for Each Room Schematic 
4.2.12. Schematic Symbol Features and Display Options (Figures 18-22) 

5. ECAV Equipment Racks………………………………………………………………………………………………………Page 23 
5.1. Purpose 
5.2. Procedure 

5.2.1.  Transform Headend Block Devices into Rack Mount Devices 
5.2.2.  Re-Position Rack Device Symbols 
5.2.3.  Configure Rack Device Symbols 
5.2.4.  Show Back of Rack  
5.2.5.  Add Rack Reports  
5.2.6.  Equipment Rack Symbol Features and Display Options (Figures 23-24) 

 
 
 
 
 
 
 
 



Page 4 of 25 
 

Symbol Logic Copyright © 2021  ECAV-Quick Reference Guide  

1. ECAV Setup 

 
1.1. Create your Company Template 

 

1.1.1. Title Page – Company, Regional and Template Settings 

1.  Make a copy of your original ECAV file folder for backup purposes. 

2. Name the backup folder “Backup ECAV”. 

3. Open the ECAV template from the original ECAV folder. 

4. On the Shape Data Window on the Title page, enter your company data, regional settings, and 

 preferred Page Size for your drawings. C-size is recommended. 

5. Select All Pages in the Page Size drop down list under Template Settings. All provided Page 

 Tabs (pages) will be shown on the bottom of the page with the C-size (24 x18 in) pages to the 

 left. 

6. If you choose a different page size other than C, move those page tabs, one at a time, in their 

 original order, all the way to the left of the C size tabs. This allows easier page navigation and 

 printing of your selected page size. 

7. You can also choose to delete all other non-usable page tabs but do not delete the Background 

 page of your selected page size. 

8. Project settings are entered after your template has been created. 

9. For each project you will enter the Project Title, Drawn By, Project Manager, and Prewire      

 Length. 

10. The Prewire Length sets the global default wire length for Block Diagram wires in the project 

 however, these lengths can be changed on the individual wires in the Shape Data window. 

1.1.2. Import the ECAV Stencils 

1. From More Shapes on the Shapes window select Open Stencil. 

2. Search for the main ECAV folder to open the ECAV stencils folder. 

3. Select all ECAV stencils and click Open. 

4. All ECAV stencils should now populate in the Shapes window of the template. 

5. Stencils are categorized files where all your symbols are stored. 

1.1.3. Stencil File Locations 

1. From the File menu, go to Options, then Advanced. 

2. Set the check boxes as shown in Figures 1 and 2, except for your desired preference for Zoom 

on roll. 

3. As shown in Figure 2, click the File Locations button, then in Stencils, browse to the location of 

the ECAV stencils. This will allow the template to find the stencils each time the template is 

opened to create a new project. 

4. If you want to store your ECAV stencils in another location, move the ECAV stencils folder to 

the new location and repeat step 3. 
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1.1.4. Saving Custom Symbols to the Stencils 

Any changes or updates to the default symbols as you work should be dragged into and saved 

in the provided custom stencils. You will be asked if you would like to open the stencil for 

editing, click Yes. When done, click the disc icon on the stencil to save your updated symbols to 

be used for future work. 

1.1.5. Quick Access Toolbar 

1. From the Quick Access Toolbar at the top of the drawing window, click on the down arrow and 

select More Commands. 

2. Choose All Commands in the Choose Commands From list as shown in Figure 3. 

3. Select the commands shown on the right from the All-Commands list on the left, then add each 

command to the list on the right, arrange the order of the list, then click OK. 

1.1.6. Company Logo, Title, Background and Foreground Pages 

1. In the rectangular placeholders provided, copy, paste and size your company logo image on the 
Title page and any required background pages of the template. The size of the rectangular 
placeholders can be changed somewhat to accept different shape logos. 

2. The background page tabs of the template are in italics at the bottom right of the drawing 

window. The background pages provide see-through text and images for the foreground (work) 

pages. 

3. To delete or change a page in the project, right-click the page tab of interest and select the 

appropriate item in the list. Use Duplicate when adding more pages to your project as this 

method copies all important page data. 

4. When adding and/or renaming pages, always include the words Floor Plan, Block Diagram, 

Schematics or Racks in the new name to allow automated Snap and Glue to identify the page 

type. 

1.1.7. Save your New Company Template 

1. Display the Title page. Then from the File menu click Save As and select a location to save your 

company template. 

2. Type the name you want for the template (i.e., “your company name Template”) in the File 

name box. 

3. Make sure the Save as Type is “Visio Macro-Enabled Template”, then click Save. 

4. Close the ECAV template, then open your newly created company template. 

5. Your company template will open as “Drawing 1” and will show the Title page. 

6. Access Project Information by either right clicking the title page and selecting Project              

 information or from the title page’s Shape Data window. 

7. Enter all new project information including the projects prewire length and click OK. This 

automatically populates information on the title blocks on each drawing page. 

8. Only when saving your work for the first time on a new project will you be prompted to select a 

location and name for the new drawing file. When later opening that file, you can make changes 

and updates and simply click Save. The original start date and revised dates will automatically 

populate in all the page’s title blocks. 
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9. If you want to change or update your company template, open the company template and make 
the changes, then display the Title page. Then, from the File menu click “Save As” and make 
sure the “Save As” Type is “Visio Macro-Enabled Template”, then click Save to overwrite your 
original company template. 

 
 
 
 

Figure 1                Figure 2  
 
 
 

Figure 3  
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1.2. Create your Engineering Database  

1. Creating and then linking your engineering database to your design drawings will allow you to 

display technical data on your drawings and run important drawing reports, further expanding 

the value of your drawings. 

2. The provided example database shown in Figure 4 shows the necessary columns of technical 

data that can be linked to your device symbols in your drawings. After linking, each row of data 

in the database will be associated with device symbols with the same Reference ID. 

3. Use the provided example Excel database as the start of your own engineering database. 

4. If any data is missing from the database, it will not appear in the ECAV device symbols or 

reports. 

5. If you want to add more database columns, the extra data will be added to the ECAV device’s 

existing data fields after linking but will not be included in any default reports. Custom data 

reports would therefore need to be created. 

1.3. Link your Database to your Drawings 

1. Import the database to the drawing by selecting Custom Import from the Data menu and follow 

the Data Selector Wizard. When done, the imported external data window will appear at the 

bottom of the drawing. 

2. Link the external data rows to your block diagram device symbols by first selecting the symbols 

and then by right clicking the External Data row and choose Link to Selected Shapes if the 

devices do not have a Reference ID. Choose Link Data if the device symbols already have 

Reference IDs. 

3. Or create block diagram devices directly from the database by first selecting only the Block 

Device symbol in the Block Diagram stencil. Then drag the database device row onto the 

drawing page to create the device! 

4. After Linking, notice the Shape Data window of the block devices now have linked data values 

associated with the database. 

5. The device data can now be passed on automatically to schematic devices and rack mount 

devices by using the Copy Shapes function on the device’s right-click menu. 

6. The device data can be used to create a bill of material report from the block diagram and rack 

elevation drawings.  

7. Any updates made to the external database will update only the Block Diagram drawing if 

Refresh data from the Data menu is initiated.    

8. The database can be part of your new template, so that it’s quickly available every time you 

open a new project. After importing the database to a new and clean project, simply save the 

project as your company template to overwrite your original template. 

1.4.  Important Drawing Notes 

1.4.1. The Drawing Process  

1. To effectively complete the four key drawings of a new project, one drawing must be completed 

before the next in the following progressive order: Floor plans first, then the Block Diagram, then 

the Schematics and last, the Rack Elevations. This progression is accomplished by using the 

template’s left to right drawing page tabs at the bottom of the ECAV drawing window. 

 



Page 8 of 25 
 

Symbol Logic Copyright © 2021  ECAV-Quick Reference Guide  

 

2. When there are changes to a project, drawing updates should begin with the left most drawing 

being affected and progressing to the next affected drawing to the right, and so on. 

3. This progressive flow of drawings allows you to start with a conceptual AV design (AV floor 

plan) and work up to the more detailed engineering drawing schematics. 

1.4.2. Example Drawing and ECAV Help 

1. Before jumping headfirst into a blank project, look over the example drawing to help guide you 

through the progressive process. 

2. Notice how each drawing type reveals more information than its previous drawing type. 

3. Notice the use of pre-defined symbol colors to represent 17 different system categories, see 

Figure 7. 

4. Click on a page symbol and look at its Shape Data window to get a feel for the associated data 

that is linked to the symbols. 

5. Look at the reports to see how the linked data is used in the bill of materials. 

6. Look at the wire’s Shape Data window and associated Pre-wire schedule reports.     

7.  Each page type has a special help layer and access to tutorial videos.    

1.4.3. Gridlines and Guides 

1. When moving device and wire symbols on the page, use the gridlines and guides to help snap 

the symbols in perfect alignment. 

2. The red and blue guides are for the right and left edges of rooms. The green guides are for the 

right edges of devices.  The blue guides are for the left areas.  

1.4.4. Snap and Glue 

1. The different Snap and Glue settings needed for different drawing pages is automatically set for 

you. However, sometimes it may be helpful to make changes to these settings by selecting the 

View menu and then Visual Aids. The automatic settings will be re-established when changing 

pages. 

1.4.5. Wire Labeling 

1. To ID your floor plan, block and schematic wires by sequentially clicking on the wires, right-click 

any wire and select Wire Labeling. 

2. In the “Number Shapes” window set the parameters as shown in Figure 5 and 6 and make sure 

you uncheck Exclude connectors as shown in Figure 10. Then click OK to begin sequentially 

numbering wires. 

3. You can also manually ID or change the labeling of wires by changing the Wire Number field in 

the wire’s Shape Data Window. 

1.4.6. Symbol Features and Display Options 

1. ECAV provides three methods to visualize and update symbol features and data: the right-click 

menu, the Shape Data window, and the symbol Form selected from the right-click menu. 

Making changes to more than one symbol at a time can only be accomplished using the Shape 

Data window. 
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Figure 4 

 
Figure 5                                                                 Figure 6                                                                        Figure 7    

 

2. ECAV AV Floor Plan 
 

2.1.  Purpose 

This drawing is created to convey to all project stakeholders the conceptual design and location 
of all key devices on the property. Pre-wires and conduits can also be shown. This drawing also 
helps to develop the full system block diagram. Additionally, during initial client meetings, drag 
AV floor plan symbols with price allowances onto the floorplans and build quotes on-the-fly and 
review system design. 

2.2.  Procedure  

2.2.1. Insert an Architectural Floorplan Image 

1. Begin by inserting an architect’s PDF or CAD floor plan image on an ECAV AV floor plan page 

as described below. 

2. PDF: From Adobe Acrobat Reader, remove any unwanted PDF layers from the architect’s 

image. Then click “Take a Snapshot” from the Acrobat’s Edit menu. Drag a box around the PDF 

image you want to capture and paste the captured image onto an ECAV floor plan page. Size 

the image to fill the page. 

 
 

Figure 5

Figure 6 Figure 7 Figure 8

Figure 9 Figure 10
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3. From the Visio Home menu, select Assign to Layer from the Layers menu and create a name 

for the captured image by clicking the New button, click OK. Then select Layer Properties from 

the Layers menu and check the box to lock that layer. 

4. CAD: From Visio, click CAD Drawing from the Insert menu and browse to search for the CAD 

drawing. Double-click the CAD drawing, then in the CAD Drawing Properties window, adjust the 

CAD drawing scale to best fit the image to the ECAV drawing page. On the Layers tab set the 

appropriate visibility and colors desired for the different CAD layers and click OK. Later, you can 

right-click the CAD image and select “CAD Drawing Object”, then Properties to make changes 

to the CAD image. 

2.2.2. Drop the Floor Plan Device Legend Symbol 

1. From the Floor Plan stencil, drop an AV floor plan legend symbol on the page and position it out 
 of the way of the floor plan image and symbols. 

2.2.3. Drop the North Symbol 

1. Similarly, drop a North Symbol on the page to indicate the plan’s north direction. 
2.2.4. Drop AV Floor Plan Device Symbols 

1. Drop AV floor plan device symbols from the Floor Plan category stencils on top of the architect’s 

image to represent the general locations of all key technology devices in your design. 

2.2.5. Resize Device Symbols 

1. Size the symbols appropriately for your image and use the symbol’s leader lines, where 

appropriate, to better define device locations on the plan. 

2.2.6. Configure Device Symbols 

1. Configure the device symbols by entering location, mounting and technology data (see Figure 8) 

in the right-click menu, Shape Data window, or Form of the symbol. To enter common data in 

more than one symbol at once, multi-select the device symbols you want, then enter the data in 

the shape data window. You can also import data from the data base (See 1.2 Create your 

Engineering Database).  

2. To reuse the custom symbols, you can now store the new custom device symbols into the Floor 

Plan (Custom) stencil.  

2.2.7. Drop AV Floor Plan Wire Symbols 

1. If showing wires on the plan is desired, drop AV wires (choice of curved or right-angled) on the 

page from the Floor Plan stencil and glue the non-text wire ends to the AV floor plan symbols. 

2.2.8. Configure Wire Symbols 

1. Configure the wire symbols by entering location, mounting and technology data (see Figure 9) in 

the right-click menu, Shape Data window, or Form of the symbol. To enter common data in 

more than one symbol in one step, multi-select the wire symbols you want and enter the data in 

the shape data window. 

2.2.9. Reposition Wire Handles 

     1.   Move the positions of the control handles of the wire shape, wire-end and text to not interfere                 
 with other symbols or important details on the architect’s image. 
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2.2.10. Set Display Options for Device and Wire Symbols 

1. Decide which data properties of a symbol you want to display by making changes in the right-

click menu, Shape Data window, or Form of the symbol. This can be done on more than one 

symbol at a time by multi-selecting all the device or wire symbols you want and making display 

changes in the “Show” fields of the shape data window. 

2.2.11. Labeling Floor Plan Wires 

1. Right-click any wire to select the Wire Labeling feature to sequentially label or number wires. 

2.2.12. Customize AV Floor Plan Symbol Icons 

1. You can add customized floor plan symbols with your own icons. To do that, first select the floor 

plan symbol and then select your new icon. Right-click the group and select Load Icon. Store 

the new symbol in the appropriate stencil category for future use.  
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2.2.13.  AV Floor Plan Symbol Features and Display Options 

 

 
GENERAL NOTES: 

 

THE DISPLAY OPTIONS AND DATA PROPERTIES SHOWN BELOW ARE SELECTABLE FROM THE SYMBOL’S SHAPE DATA WINDOW OR FORM. 

 

ADDITIONAL PROPERTIES MAY BE AVAILABLE FROM WHAT IS SHOWN BELOW. 

 

CERTAIN DISPLAY OPTIONS AND FEATURES ARE SELCTABLE FROM THE SYMBOL’S RIGHT-CLICK MENU. 
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3. ECAV Block Diagram 
 

3.1.  Purpose 

ECAV’s block diagram was developed to provide a fast, easy and accurate single-page drawing 

of the entire project design and wiring structure. It fills a huge informational gap between the 

floor plan design drawings and the schematic and rack engineering drawings. This single 

diagram generates instantaneous wire schedules and bill of materials and provides diagrams of 

individual rooms and head-ends for on-site verification of area wiring and design. The block 

diagram also features the ability to transform block diagram symbols into detailed schematic 

and rack elevation symbols, enabling those drawings to be created faster, easier and with 

minimum chance of error. 
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3.2.  Procedure  

3.2.1. Drop Room Symbols 

1. Begin by dragging and snapping Room symbols between the red and blue guides on the right-

side of the block diagram page and fill-in the “To” data in the pop-up window (See Figure 12). 

2. Repeat for all remaining rooms in the project. 

3.2.2. Floor-Bar Symbols 

1. Copy or delete any needed left and right Floor Bars to help show which floors the headends and 

rooms are on, see Figures 11 and 12. Label the floor bars from their shape data windows. 

3.2.3. Drop Room Area Symbols 

1. Drop Room Area symbols into rooms which include separate areas such as room cabinets, 

closets, or racks for housing electronics. Use the blue guide to position the left edge of area 

symbols. They may need to be re-positioned when all other symbols are in place. (see Figure 

12). 

3.2.4. Drop Headend Area Symbols 

Drag and snap Headend area symbols between the red and blue guides on the left-side of the 

block diagram page and fill-in the “From” data in the pop-up window. 

3.2.5. Drop Device Symbols 

1. Drag and snap Block Device symbols to the green alignment guides in rooms, areas and 

headends. Notice, you must drop or drag devices into rooms and areas rather than position the 

rooms and areas on top of devices. This allows the proper transfer of room and area data into 

the device.   

3.2.6. Type-in Device Names 

1. Type a general Name abbreviation for the device in the Shape Data window or Form to easily 

identify the type of device. Later, this device will be more specifically defined by manufacturer, 

model, and reference ID, etc. after data linking. 

2. Repeat steps 3.2.5 and 3.2.6 for all other room device symbols in the project.  

3.    Repeat steps 3.2.5 and 3.2.6 for all headend device symbols. 

3.2.7. Drop Room Wire Symbols 

1. Drop Room Wire symbols onto the rooms and connect them to room devices. Notice, you must 

connect wires to devices rather than moving devices to connect wires. This allows the proper 

transfer of device data into the wire. These wires will be the pre-wires run to the headend(s). Do 

not try to assign any wire type data yet. 

3.2.8. Check Room Designs and Symbol Positions 

1. Check your room designs to make sure all room devices and wires are in their correct areas, 

rooms, and floors. 

2. Check the positioning of all symbols to make sure they are neatly organized in a riser-style 

layout. 
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3.2.9. Assign Groups to Room Wires 

1. From the rooms on the right, multi-select all the wires which are the same wire type and function 

and select the letter “A” wire group from the shape data window. During installation, these wires 

are pulled to the same headend location and have the same function. 

2. Repeat for all the other wire groups and select a different letter for each of the groups. 

3.2.10. Assign Average Project Wire Length 

1. The default wire length for all block diagram wires is set on the Title page under Prewire length. 

You can change any of these lengths in the individual wire’s Shape Data window.   

3.2.11. Drop and Configure Headend Wire Groups 

1. Drop Headend Wire Group symbols onto the headend areas and connect them to the right ends 

of headend devices, see Figure 13. Select “A” for the first wire group letter in the shape data 

window. 

2. Repeat for all other headend wire group symbols. Each lettered headend wire group symbol 

represents all the room wires with the same wire group letter, wire type and function. 

3. From the shape data window of each headend wire group symbol, enter all wire data for that 

wire group. This will automatically update all room wires of that wire group. 

3.2.12. Assign Room Wire IDs 

1. Right-click any room wire to select the Wire Labeling feature, then sequentially number all room 

wires. 

3.2.13. Drop Prewire Schedules 

1. Drop a Pre-Wire Schedule symbol from the Block Diagram stencil on the page to automatically 

generate a pre-wire schedule. Move the report to the right side of the page.  

3.2.14. Interconnect Block Devices 

1. Interconnect devices in rooms and headends using the Connector symbol in the Block Diagram 

stencil. These connections only help to visualize the basic connectivity of the equipment and do 

not hold any data. 

3.2.15. Check Headend Designs and Symbol Positions 

     1. Check your headend designs (left side of page) to make sure all head-end devices and wires         

  are in their correct areas and floors.  

2. Check the positioning of all symbols to make sure they are neatly organized in a riser-style 

layout, refer to the Example Drawing. 

3.2.16. Link your Company Data to Device Symbols 

1. After visualizing the size and scope of the project, you can now link your database to devices on 

the drawing (see 1.3 Link your Database to your Drawings). 

2. To reuse the custom symbols, you can now store the new custom device symbols into the Block 

Diagram (Custom) stencil. 

3.2.17. Drop Block Diagram Device Legend and BoM Report Symbols 

1. Drop a Device Legend and a BoM Report symbol from the Block Diagram stencil on the page to 

automatically generate these reports. 



Page 16 of 25 
 

Symbol Logic Copyright © 2021  ECAV-Quick Reference Guide  

3.2.18. Block Diagram Symbol Features and Display Options 

 
GENERAL NOTES: 

 

THE DISPLAY OPTIONS AND DATA PROPERTIES SHOWN BELOW ARE SELECTABLE FROM THE SYMBOL’S SHAPE DATA WINDOW OR FORM. 

 

ADDITIONAL PROPERTIES MAY BE AVAILABLE FROM WHAT IS SHOWN BELOW. 

 

CERTAIN DISPLAY OPTIONS AND FEATURES ARE SELCTABLE FROM THE SYMBOL’S RIGHT-CLICK MENU. 
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4. ECAV Schematics 
 

4.1.  Purpose 

The headend rack and room schematics are the detailed point-to-point wiring diagrams used to  

  wire the equipment racks and room electronics. They are also used during system                  

      programming, servicing and upgrades. The drawings themselves can be used to monitor the  

      progress of rack wiring by using the built-in wire symbol installer colors. 

4.2.  Procedure  

4.2.1. Name Rack and Room Outline Symbols 

1. Begin by naming the racks and rooms on the Rack and Room Schematic pages respectively, 

just as they are named on the block diagram page. For the Headend/Rack Schematic page click 

the broken-line outline, then select or type-in the given name of the rack in the Area field in the 

shape data window. Similarly, for each of the rooms on the Rooms Schematic page, select the 

room outline and type the Room Name given to the room in the shape data window. The 

broken-line outlines represent the physical boundary of the racks and rooms. Typically, one, 

two, or three headend rack schematics can be shown on a single rack schematic page. Many 

rooms can be shown on one room schematic page. 

4.2.2. Transform Headend Block Devices into Schematic Devices 

1. On the block diagram page, select one or more block diagram symbols in one of the headend 

rack areas. From the symbol’s right-click menu select Copy Shapes. On the Copy Shapes 

Form, select Copy to Schematic Device and select Rack Schematics as the Target Page. 

2. Click OK to paste the selected headend components to the top of the blank rack schematic 

page. 

4.2.3. Reposition Schematic Device Symbols 

1. Move the pasted schematic device symbols to their appropriate positions on the schematic 

page. Right-click and select devices that are I/O Cards. Right click any devices that are 

internally rack mounted devices (“Show Internally Mounted”) rather than face-mounted devices. 

see Figure 15 and 18. 

2. Repeat section 4.2.2 and step 1 above for all the other headend device symbols within that 

rack. 

4.2.4. Create Schematic Device I/Os 

1. Right-click the schematic device symbol and select Edit I/O Ports to create or modify the I/O 

ports for each symbol, see Figure 14. Refer to the Wire Termination page when selecting I/O 

termination detail reference numbers. When done, to reuse the symbol for any future work, 

store the new schematic device symbol into the Schematics (Custom) stencil. 

4.2.5. Reposition Completed Schematic Symbols 

 1. Position all device symbols neatly in an organized layout, generally with input devices on the  
      left, output devices on the right, processing devices in the center and power management  
      devices on the bottom left of the page. 



Page 19 of 25 
 

Symbol Logic Copyright © 2021  ECAV-Quick Reference Guide  

 

 

 

4.2.6. Transform Block Diagram Room Wires into Schematic Wires 

1. Repeat the copy/paste function in steps 2 thru 5, but with block diagram room wires. These (To) 

room wires will generally be connected to device outputs on the right side of the rack schematic 

page as shown in Figure 18. 

4.2.7. Drop Interconnect and Wire Reference Symbols 

 1. Drop Schematic wire symbols onto the page. Change the default wire symbol from Output Wire        
  to Interconnect Wire from the Line Type setting on the Shape Data window and interconnect  
      device symbols as needed.  Drop Wire Reference symbols onto the schematic drawing and  
      interconnect device symbols as needed. (See Figures 17 and 18) 

4.2.8. Label Interconnect Wire Symbols 

1. Right-click any interconnect wire to select the Wire Labeling feature to sequentially number all 

schematic interconnect wires. 

4.2.9. Check All Rack Connections and Headend Design 

1. Verify that all schematic connections and wire numbers are correct. 

4.2.10. Show Tech-Installed Wires 

1. To show that rack or room wires have been installed, select one or more of the wire symbols 

(installed wires) and select the technician (color) who installed the wire(s) in the “Installed By” 

field of the shape data window. Similarly, you can right-click an individual wire symbol to select 

the Installed By technician (color). 

4.2.11. Repeat Procedure for Each Room Schematic 

1. Repeat all the previous steps, except copy/paste room devices and room wires from each room 

of the block diagram onto rooms in the Rooms Schematic page(s), see Figure 19. 

2. Note, the block diagram room wires copied to the headend/rack schematics are the same wires 

copied again to the room schematics. The references “To” and “From” on each wire are used to 

distinguish the location of the wire ends.  “To” is the wire end at the room, and “From” is the wire 

end at the rack. Therefore, for room wires you will need to change those wires from Output Wire 

types to Input Wire types from the Line Type setting in the Shape Data window for the pasted 

room wires, see Figure 19. 
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4.2.12. Schematic Symbol Features and Display Options 

 
GENERAL NOTES: 

 

THE DISPLAY OPTIONS AND DATA PROPERTIES SHOWN BELOW ARE SELECTABLE FROM THE SYMBOL’S SHAPE DATA WINDOW OR FORM. 

 

ADDITIONAL PROPERTIES MAY BE AVAILABLE FROM WHAT IS SHOWN BELOW. 

 

CERTAIN DISPLAY OPTIONS AND FEATURES ARE SELCTABLE FROM THE SYMBOL’S RIGHT-CLICK MENU. 
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5.0 ECAV Equipment Racks 
 

5.1.  Purpose 

  The Rack Elevation drawing is used to build the project’s equipment racks. The drawing shows  

  the correct placement of all rack mounted components, and the report shows the rack bill of  

       materials as well as weight, power and ventilation requirements. 

5.2.  Procedure  

5.2.1. Transform Headend Block Devices into Rack Mount Devices 

 1. On the block diagram page, multi-select all the block diagram device symbols from one   

  headend rack area. Do not select any block diagram I/O card devices if used, as these do not  

  require rack mounts. 

2. From the symbol’s right-click menu, select Copy Shapes. On the Copy Shapes Form, select 

Copy To: Device Mount and select Rack Elevations as the Target Page. 

3. Repeat steps 1 and 2 for all other headend areas. Multiple racks can be shown on one page if 

desired. 

5.2.2. Reposition Rack Device Symbols 

1. From the top of the rack elevation page re-position the device mounts appropriately in a vertical 

column on the page.  

2. Copy and paste each new device rack mount symbol in the Equipment Rack (Custom) stencil 

for future use.  

5.2.3. Configure Universal Rack Symbol          

    1.  Drop a universal rack symbol on a page and link the rack data row if you have it for, automatic          

  rack configuration. If you don’t have the rack data row, configure the rack manually in the  

       Shape Data window. In either case add the height of an Accessory Base, if used, in the Shape  

  Data window.   

5.2.4. Show Back of Rack 

1. You can show the back of the rack if devices are to be mounted on the back by adding an 

additional rack on the page. Just type in “Back of Rack” instead of “Manufacturer” in the Shape 

Data window for the added rack. see Figure 20 and 21.  

5.2.5. Add Rack Reports 

 1. Drop rack bill of materials, rack dimensions, and power and ventilation symbols on the page to  

  automatically generate the rack reports.   
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5.2.6. Equipment Rack Symbol Features and Display Option 

 
GENERAL NOTES: 

 

THE DISPLAY OPTIONS AND DATA PROPERTIES SHOWN BELOW ARE SELECTABLE FROM THE SYMBOL’S SHAPE DATA WINDOW OR FORM. 

 

ADDITIONAL PROPERTIES MAY BE AVAILABLE FROM WHAT IS SHOWN BELOW. 

 

CERTAIN DISPLAY OPTIONS AND FEATURES ARE SELCTABLE FROM THE SYMBOL’S RIGHT-CLICK MENU. 
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